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This software is copyrighted by IKEGAMI TSUSHINKI CO., LTD. 
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Cautions when Operating 

Important Basic Precautions 

 
(1) Please be sure there are no abnormalities or defects 

in the construction or function of this device. 

 

(2) This device is not sterile. To maintain cleanliness, 

place both this device and the microscope on a 

drape when using. 

 

Safety Precautions 

For the proper and safe use of this device 
Be sure to thoroughly read these "Safety Precautions" and 

the user manual before use. Keep this manual handy for 

future reference. 

Symbols 
Various symbols are used in these "Safety Precautions" 

and in the description of product use in order to prevent 

personal injury and property damage, and to ensure the 

proper and safe use of this product. These symbols and 

their meanings are shown below. Be sure to understand 

them before using. 

HAZARD: Failure to observe this hazard may 

result in an emergency situation, 

leading to death or serious injury. 

 

WARNING: Failure to observe this warning 

may result in death or serious 

injury. 

 

CAUTION: Failure to observe this caution 

may result in personal injury 

and/or property damage. 

 

Note: Information calling for attention is described with the 

symbol. 

 

Examples of Symbols 

This symbol indicates a prohibited action. 

Specific examples of prohibited items are 

illustrated in the figure or adjacent area. 

(The figure on the left means caution during 

disassembly.) 

 

 

Examples of Symbols 

● This symbol indicates an instruction and 

implementation of an action. 

Specific examples of cautions are illustrated 

in the figure. (The figure on the left means 

"Unplug the electrical plug from the power 

outlet.) 

This symbol advises the operator to read the 

accompanying documentation. 

 

 WARNING 

During use 

Do not put a container filled with water or 

small metal objects on the device! 

Spilling water on the device may result in 

fire and/or electric shock. 

Do not use a power supply voltage other 

than the voltage indicated! 

This may result in fire and/or electric shock. 

Do not insert or drop foreign materials 

(metals, flammable material, etc.) through 

openings in the device! 

This may result in fire and/or electric shock. 

Do not modify this device. 

This may result in fire and/or electric shock. 

 

 

During installation 

Do not place the device on an 

unstable surface! 

The device may drop or turn over, resulting 

in injury. 

Only connect the designated device! 

Connecting other devices may cause a fire 

and/or electric shock. 

Only connect to a commercial power 

supply! 

・In order to avoid risk of electric 

shock, this device should only be 

connected to a power supply 

(commercial) with protective 

grounding. 

・Be sure to use a power outlet with a 

ground. 
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When an abnormality is detected 

If abnormal conditions, include smoke, a 

strange odor or noise are observed, 

immediately turn off the power and unplug 

the power plug. 

Continued use may result in a fire and/or electric 

shock. Confirm there is no more smoke, and 

contact to the sales representative. 

If water or foreign matter gets inside, turn off 

the power and unplug the power plug. 

Continued use may result in fire and/or electric 

shock. Please contact to the dealer or sales 

representative. 

If the device is dropped or the case is 

damaged, turn off the power and unplug the 

power plug. 

Continued use may result in fire and/or electric 

shock. Please contact to the dealer or sales 

representative. 

If the device is failed, turn off the power 

switch and unplug the power plug. 

Continued use may result in fire and/or electric 

shock. Please contact to the dealer or sales 

representative. 

Do not use a damaged power cord (exposed 

core or broken wire)! 

Continued use may result in fire and/or electric 

shock. Please contact to the dealer or sales 

representative. 

 

       CAUTION 

During Use 

Do not put heavy objects on top of the 

device! 

These may tip over or fall off, resulting in injury. 

Do not stand or sit on the device or the 

carrying case! 

These may break or tip over, resulting in injury. 

When moving the device, turn off the 

power, unplug the power plug, and 

disconnect any cables between devices. 

Not doing so may damage the power cord or 

cables, resulting in fire and/or electric shock. 

After use, be sure to turn off the power, 

and then unplug the power plug. 

Not doing so may result in damage, fire and/or 

electric shock. 

If the device will not used for a long 

time, be sure to unplug the power plug 

from a power outlet for safety. 

Not doing so may result in fire. 

 

During installation 

Do not block the vent of this device! 

If the vent is blocked, heat may build up inside 

and cause a fire. Observe the following points. 

・Do not place this device face up, on its side, or 

upside down. 

・Do not place this device into a poorly ventilated 

small space. 

・Do not place the device on a carpet, etc. 

・Do not cover the device with a tablecloth, etc. 

Do not place the device in a location with 

poor power supply access. 

To do so may damage the cord, and cause a 

fire. 

Install the device in a location where it does 

not hinder disconnecting the cord. 

When the camera head is attached to the 

adapter and microscope, pay attention to the 

following points. If not securely attached, it 

may fall off during use, resulting in injury or 

death. 

・Securely screw the camera head to the C-

mount ring of the adapter. 

・When attaching the adapter to the beam 

splitter of microscope, be sure that the 

accompanying tightening ring or 

accompanying adapter tightening ring is 

securely tightened. 

・Check the connection, make sure it is not 

loose before using the device. 

Instructions for Proper Use 

During Use 

・If this device is used in a wet location, be sure 

water does not get inside the device or cable, 

etc. 

This may result in electric shock. 

・If you hear thunder, consider the environmental 

conditions before use. If needed, discontinue use 

and do not touch the device. 

This may result in electric shock. 

・Do not connect the device to a power 

supply(W) exceeding that of the AC outlet. 

Refer to the power rating indicated on the AC outlet 

peripheral area, user manual, operation manual, etc. 

・Do not forcefully bend (twist or pull) the power 

cord and connection cable during use. 

This may tear the coating on the cord or cables causing 

electric shock. 

・Contact the sales representative for replacement 

parts (power cable). 

If needed, replace the power cable with the same 

or equivalent product. If the supplied power cable 
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is damaged, contact the sales representatives for 

replacement. 

 During installation 

・Avoid areas with high humidity and dust, as well as 

areas where oily smoke or steam may blow directly 

onto the device. 

Not doing so may result in electric shock. Do not place 

the device on the kitchen counter or near a humidifier. 

・Secure the device to prevent it from falling over in 

the event of an earthquake, impact, etc. 

An unsecured device may fall down and cause injury. 

Avoid falls to maintain safety. 

 

Camera cable 

Cleaning 

・For safety, turn off the power and remove the power plug 

before cleaning. This may result in electric shock. 

・Wipe lightly the enclosure and panel with a dry soft 

cloth. 

・"Regular inspections" are recommended to maintain 

stable performance for a long time. Consult with sales 

representative to schedule regular inspections. 

・This device contains high voltage component. 

Consequently, inspection, maintenance and repairs 

should be performed by a professional. Handling by a 

person without proper knowledge may result in electric 

shock. 

 

Inspections 

Regular inspections are recommended for the safe 

use of this device. 

Maintenance and inspection by users (daily 

inspection) 

1. Visual inspection 

(1) Check the exterior 

・Check for any abnormalities including damage and 

wear on the exterior of the device and cable. 

(2) Check for cleanliness 

・Be sure the device is clean. 

・Be sure there are no body fluids, blood, waste 

material, contrast medium, etc. on the device. 

(3) Check the surroundings 

・Be sure there are no objects which may hinder device 

operation. 
 

2. Function check 

(1) Check the condition of the device 

・Be sure the device is operating normally. 

・Check for any unusual noises or odor. 

(2) Be sure the device is securely attached. 

 

 

 

 

 

 

 

 

・If the camera head is attached to a rotating platform, etc., 

clamp the camera cable so excessive force is not applied to 

the cable when moving. Be sure not to kink (twist, bend) the 

cable. If the cable is distorted, the wire rod inside the cable 

may break. 

・Before use, check for damage or deterioration of the cable and 

lacing material. 

Camera head 

Radius of 75mm 

or more 

Connect

or 

Radius of 75mm 

or more 

Camera cable 

Pay attention to the following points. 

・Always use the supplied camera cable. 

Connecting the wrong camera cable may damage the device. 

・When removing the camera cable from the camera head or 

CCU, do not pull the cable. Grasp the connector (plug) to 
remove. 

・Do not crush the cable. 

・Do not insert or remove the camera cable while the power is 

on. 

・ The acceptable bending radius of the camera cable is 

approximately 10 times of the external radius of the cable 
(75mm for φ7.5mm cable). Do not forcefully bend the cable in 
excess of this radius. If the cable is forcefully bent, the wire rod 
inside the cable may break. 
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Inspection list 

WARNING 

Before use, be sure the operator of this device has 

been thoroughly instructed on the proper use of this 

device. 

If the operator has not been properly instructed, this 

may result in incorrect use and substandard 

performance such as degraded image. 

 

Inspections 

Please check the following before using this device. 

(1) Visual inspection 

□ The blue indicator is lit when the power is turned 

on. 

(2) External check 

□ Camera head 

□ CCU 

□ Camera cable 

□ Peripheral device(s) and cable(s) 

□ Power supplied from the AC outlet 

□ The cooling fan is working 

□ Display and operation of the front operation 

panel are normal. 

□ No damage or wear on any component. 

□ The device is properly connected to peripheral 

devices. 

 

Disposal 

Dispose this product in compliance with the laws and 

regulations of the municipality. 

Please consult with your municipality for details. 

 

 

MKC-X800 is an authorized AAMI ES60601-1/EN60601-

1 ClassⅠ product. The IP rating of MKC-X800 is IPX0. 

The MKC-X800 device is for continuous operation. 
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Guidelines and manufacturer's declaration - electromagnetic emissions 

The Model MKC-X800 is intended for use in the electromagnetic environment specified below. 

The customer or user of the Model MKC-X800 should confirm that the environment is in 

compliance. 

Emissions test Compliance Electromagnetic  

RF emissions CISPR 

11 
Group 1 

The Model MKC-X800 uses RF energy only for 

internal functions. Therefore, RF emissions are very 

low and are unlikely to cause any interference to 

nearby electronic equipment. 

RF emissions CISPR 

11 
Class A 

Emission characteristics of this product are suitable 

for industrial and hospital environments (CISPR 11 

Class A) 

In a domestic environment, MKC-X800 may cause 

radio interference, in which case mitigation 

measures may be required, such as re-orienting, 

relocating, shielding the unit, or filtering the 

connection to a public main network. 

Harmonic emissions 

IEC61000-3-2 
Class A 

Voltage 

fluctuations/flicker 

emissions IEC61000-

3-3 

in compliance 
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Immunity test 
IEC 60601 test 

level 
Compliance level 

Electromagnetic environment 

conditions 

Electrostatic  

discharge(ESD) 

IEC61000-4-2 

±8kV contact 

±15kV air 

±8kV contact 

±15kV air 

Floors should be wood, 

concrete or ceramic tile. If 

floors are covered with a 

synthetic material, relative 

humidity should be at least 

30%. 

Electrical fast 

transient/burst  

 

IEC61000-4-4 

±2kV for power 

supply lines 

±1kV for 

input/output lines 

±2kV for power 

supply lines 

±1kV for 

input/output lines 

Main power level should be 

that of a typical commercial 

or hospital environment. 

Surge 

IEC61000-4-5 

±1kV differential 

mode  

±2kV common 

mode  

±1kV differential 

mode 

±2kV common 

mode  

Main power level should be 

that of a typical commercial 

or hospital environment 

Voltage dips, short 

interruptions and 

voltage variations 

on power supply 

input lines. 

 

 

IEC61000-4-11 

0% Ut 

For 0.5/1/250/300 

cycle 

70% Ut 

(30%dip ln Ut) 

For25/30 cycle 

0% Ut 

For 

0.5/1/250/300 

cycle 

70% Ut 

(30%dip ln Ut) 

For25/30 cycle 

Main power level should be 

that of a typical commercial 

or hospital environment. If 

the user of the MODEL MKC-

X800 requires continued 

operation times when the 

main power may be 

interrupted, powering the 

MODEL MKC-X800 with an 

uninterruptible power supply 

or battery is recommended. 

Power frequency 

(50/60 Hz) 

magnetic field 

IEC61000-4-8 

30 A/m 30 A/m The power frequency 

magnetic field should meet 

the characteristics of a 

typical location such as a 

commercial or hospital 

environment. 

NOTE: A.C. main voltage prior to application of the test level. 
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Guidelines and manufacturer's declaration - electromagnetic emissions 

The Model MKC-X800 is intended for use in the electromagnetic environment specified 

below. The customer or user of the Model MKC-X800 should confirm that the environment 

is in compliance.  

Immunity test 

IEC 60601 test 

level 

Compliance 

level 

Electromagnetic environment 

conditions 

Conducted RF 

IEC61000-4-6 

 

 

 

 

Radiated RF 

IEC61000-4-3 

IEC61000-4-6 

3Vrms 

150kHz to 80Mhz 

6Vrms 

ISM Band 

 

IEC61000-4-3  

3V/m 

80MHz TO 2.7GHz 

IEC61000-4-6 

3Vrms 

150kHz to 

80Mhz 

6Vrms 

ISM Band 

 

IEC61000-4-3 

3V/m 

80MHz TO 

2.7GHz 

Portable and mobile RF 

communications should not be used 

in close proximity to any part of the 

MODEL MKC-X800, including cables, 

and should be kept at the 

recommended separation distance 

calculated from the equation 

according to the transmitter 

frequency. 

Recommended separation distance 

d=1.2√P 

d=1.2√P  80～800 MHz 

d=1.2√P  800 MHz～2.5 GHz 

where P is the maximum output 

power rating of the transmitter in 

watts (W) according to the 

transmitter manufacturer 

specifications, d is the 

recommended separation distance 

in meters(m). 

Field strength is from fixed RF 

transmitters, as determined by an 

electromagnetic site survey*a should 

be less than the compliance level at 

each frequency range*b. 

Interference may occur near 

equipment marked with the 

following symbol: 

NOTE 1: At 80 MHz and 800 MHz, the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is 

affected by absorption and reflection from structures, objects, and people. 

 ,  
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Special precautions regarding EMC are required for MKC-X800, and installation and operation should 

be carried out according to the EMC information provided in the accompanying documents. 

Avoid using MKC-X800 next to or stacked with other equipment as this my result in inaccurate operation. 

If such cannot be avoided, it should be watched to confirm normal operations in configured use 

conditions. 

Except for AC cables, all cables should be shielded. 

Use of an accessory device or cable with MKC-X800 other than those specified in this manual may 

result in increased emissions or decreased immunity. 

When using portable RF communication equipment nearby, maintain a distance of at least 30 cm. At 

distances less than this, degradation of equipment performance may occur.

*a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) 

telephones and land mobile radios, amateur radios, AM and FM radio broadcasts and TV 

broadcasts cannot be predicted theoretically with accuracy. To assess the electromagnetic 

environment due to fixed RF transmitters, an electromagnetic site survey should be 

considered. If the measured field strength in the location where the MODEL MKC-X800 is 

used exceeds the applicable RF compliance level described above, the MODEL MKC-X800 

should be watched to confirm normal operations. If operations are abnormal, additional 

measures may be necessary, such as reorienting or relocating the MODEL MKC-X800. 

*b For frequency ranges outside 150 kHz to 80 MHz, field strength should be less than 3 

V/m. 
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1 Introduction 

MKC-X800 is a 4K Camera equipped with high-definition 4K video (3840 × 2160) and color 

reproduction. It is a medical grade camera which can be used with a surgical microscope or 

shadow-less lamp system. 

MKC-X800 employs a 1 CMOS system, performs 3840 x 2160 4K format with 1800TV lines 

horizontal resolution, S/N ratio with 58dB. In addition to the 4K output signal, HD-SDI output 

(3G compatible) and DVI system are also available. 

 

2 Construction 

Part Name and Function 

Camera Head 

 

 

 

 

 
 

 

 

⚫ C-mount 

The C-mount is used to mount the lens. 

Various kinds of C-mount lenses and microscope adapters can be used. 

 

⚫ Camera connector 

The camera connector is used to connect a dedicated camera cable. 

CAUTION 

Please note that the camera connector on the camera head side and the CCU side differs in size. 

 

 

 

  

C-mount 

 

Camera connector 
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CCU Front 

 

 

 

 

 
 

 

① Power button 

The power button to turn MKC-X800 ON/OFF. 

 

② Touch sensor panel 

The touch sensor panel displays the menu screen. Operation of menu screen is possible by 

touching the screen. 

 

③ Rotary Switch 

The rotary switch is used to selecting settings and renaming scene files. 

Operation can be done by turning the dial or pushing the left or right side. 

 

  

③ 

② 

① 
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CCU Back 

 

  

 

 
 

 

① 4K OUT connector(SDIx4) (12G-SDI) 

A UHD-SDI 2-Sample Interleave Level-A (3G-SDI Quad Link or 12G-SDI) input compatible monitor etc. can be 

connected here. When output is 4K 12G-SDI, the same video can be output to all four lines. 

4K UHD coax cables for 12G-SDI (e.g. D5.5UHDC**E etc.) are recommended. 

 

② HDMI connector 

An HDMI input compatible monitor etc. can be connected here. When using this port, premium high-speed certified 

HDMI cables (e.g. DH-HDP14E50BK etc.) are recommended. 

4K video output is possible. 

 

③ ETHERNET connector 

A personal computer etc. can be connected here. A cross cable (option) is required for connection. 

CCU operation with a personal computer is possible. 

 

④ USB connector 

The is a USB port. 

A scene file setting can be loaded from here. If the scene file data is in USB, settings can be overwritten. 

 

⑤ RS-232C connector 

The personal computer etc. can be connected here. A cross cable (option) is required for connection. 

CCU operation with a personal computer is possible. 

 

⑥ FOOT SWITCH connector 

The extension cable from a foot switch (option) can be connected here. 

  

⑪ 

⑫ 
 

①  ①  ①  ①  ② ③  ④  ⑤  ⑥ 

⑦  ⑧  ⑧  ⑨  ⑩ 
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⑦ DVI-D OUT connector 

This is the image output port 

A DVI-D input monitor, etc. can be used with a DVI-D cable with ferrite core (separately sold). 

Ferrite core  

 

 

 

 

 

 

⑧ HD-SDI(3G-SDI) OUT connector (2 lines) 

An HD-SDI (3G-SDI)-input-compatible monitor etc. can be connected here. The same video is output to two lines.  

A coaxial cable with a 75 Ω impedance should be used for connection. 

 

⑨ GEN LOCK connector 

To synchronize the phase of a video with another system, a synchronizing signal from that system is input through 

the GEN LOCK connector. A tri-level sync (HD) is supported. 

 

⑩ SYNC connector 

To synchronize the phase of a video with another system, a synchronizing signal to that system is output through 

the SYNC connector. A tri-level sync (HD) is supported. 

※Synchronization of applications between MKC cameras is assumed. Synchronization between other products is 

not guaranteed. 

 

⑪ Camera connector 

The camera connector of a dedicated camera cable can be connected here.  

 

CAUTION 

Please note that the camera connector on the camera head side and the CCU side differs in size. 

 

 

⑫ DC inlet 

The power cable and AC adapter included with a commercial power (100 to 240V AC) can be connected here. 
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Accessories 

Open the box and make sure the device and the following accessories are included. 

 

⚫ Camera cable (5m) × 1 

⚫  

 

⚫ Extension cable (10m) × 1 (Option) 

 

 

⚫ Power cord × 1 

 

⚫ AC adapter 

 

 

 

 

⚫ User manual (this document) 
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3 Operation (Basics) 

Connection Example 

 

 

 

  

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

※ To connect a 4K monitor, follow the directions of the operation manual of the monitor. 

  

4K-Compatible monitor 

MKC-X800 
camera head 

Camera cable 

 

Foot switch 

HDMI cable 

DVI-D cable 75Ω coaxial cable 

DVI monitor 

MDR-600HD 

Power cable 
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Peripheral equipment 

・Use JIS T0601-1 or IEC60601-1 compatible product for the foot switch connected to this device. 

・Use JIS T0601-1, IEC60601-1, or a product that complies with the safety standard (IEC 

standard, JIS standard, PSE, etc.) for other products, except the foot switch connected to this 

device. 

Notes on the Connection 

・Be sure to turn off the main unit of camera before connecting. 

・Connect a dedicated camera head. 

Connect a different head may result in a malfunction. 

・Image output from the 3G/HD-SDI connector is on the receiving side with 75Ω 

terminal. 

・Be sure to use the accompanying power cable to connect the power supply. 
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Start-Up and Shut Down of the Main Unit 

Start-up and shut down methods for the main unit are explained in this section. 

 

Start-up method 

【Step 1】Preparation before turning on power 

Before turning on power, check the following. 

・Be sure the external devices including a camera head, monitor, etc. are properly connected. 

・Be sure the power cable (accessory) is connected to the DC inlet of the CCU rear panel, and the 

plug of the power cable is connected to the commercial power outlet. 

・The power switch light on the front of the CCU is off. 

 

 

 

 

----------------------------------------------------------- 

【Step 2】 

Turn on the power for external devices including the monitor, etc. 

----------------------------------------------------------- 
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【Step 3】 
Press the power switch on the front panel of the CCU to turn on the power. When the power is on, 

the power switch indicator turns blue. 
 

 

 

 

Notes on the Camera Image 

Immediately after turning on the power, initialization of CCU or the camera head automatically begins. 

During this time, an unstable image is displayed on the monitor, this it is not a malfunction. 

----------------------------------------------------------- 

Perform Step 1 to 3 to output the camera image to the monitor. 

* If the cable is disconnected during use, repeat the above procedures. 

 

Shut Down Method 

Press the power switch on the front panel of the CCU to turn off the power. When the power is 

turned off, the power switch indicator will no longer be lit. 
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Checking the Camera Image 

1. Turn on the camera and other connected devices. 

2. Turn on the microscope and lighting. 

3. Check image output on the monitor. 

 

3.3.1 Checking and Adjusting the Camera Image 

1. To automatically adjust the camera image, press the White Balance button on the accessory chart. 

2. Check if a normal image (appropriate brightness, color, resolution, etc.) is output. 

 

For further details and adjustment methods, refer to "3.4 Touch panel operation". 

 

 

  

 Notes when Moving the Device 

When moving the main unit, be sure to turn off the main power supply, unplug the power plug, and remove 

the connection cable between the devices. 

 Notes when Connecting or Disconnecting the Camera Cable 

When connecting or disconnecting the camera cable connecting the camera head and CCU, be sure to turn 

off the power of the main unit. 

Connecting or disconnecting the camera cable while the power of the main unit is on may cause a 

malfunction. 

Notes on the Camera Image 

This device uses a CMOS sensor. As a result, the following phenomena may be observed. These are not 

malfunctions. 

1) Bright spots may appear on the image when sensitivity is increased or the device is used at high 

temperatures. 

2) Flickering and horizontal lines appear on the screen under the lighting of discharge tubes, including 

fluorescent lights, etc. Set the electronic shutter to 1/100 in the power supply frequency of 50Hz range. 

3) Some distortion may occur on the screen for fast-moving objects. 



 

 

25 

 

Touch panel operation 

3.3.1 TOP MENU 

 

 

 

 

 

 

 

 

 

 

 

 

①  Direct adjustment with the touch panel or Rotary Switch. 

  Up to three functions can be assigned to the [TOP MENU INDICATOR] screen (→4.5.3). 

The assigned functions can be selected from TOP MENU by pressing the Rotary Switch. 

②  White balance can be adjusted automatically(→4.1). 

 

③  A scene file can be selected (→4.2). 

 

④  Function key can be selected (→4.3). 

 

⑤  Go to the Menu screen (→3.3.2). 

  

② 

④ 

⑤ 

③ 

① 
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3.3.2 Menu screen 

 

             

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

② Return to the previous screen. 

 

③ Return to the TOP MENU. 

 

④ Go to the PICTURE setting screen (→4.4). 

 

⑤ Go to the FUNCTION setting screen (→4.5). 

 

⑥ Go to the SYSTEM setting screen (→4.6). 

 

⑥ Display the OSD menu (→5). 

 

① ② 

③ 

⑤ 

④ 

⑥ 
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3.3.3 Screen lock/unlock 

  To prevent accidental operation, the menu screen can be locked. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Long press the button for about 3 seconds. 

 

When the yellow lock mark is displayed, the lock function is activated. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 <Unlock> 

 When the ②button is pressed, Screen③ is displayed. 

    Select [YES] to unlock. 

 

  

① 

③ ② 



28 

 

4 Function  

4.1 White balance 

Adjust the white balance when using the MKC-X800 for the first time or when replacing the light  

source used. White balance can be adjusted automatically. 

＜Operation＞ 

１． Shoot a white photographic object on the screen, and press the [AWB] button. 

● During automatic adjustment, “AWB BUSY” is displayed on the monitor screen. 

 

 

 

 

 

 

 

 

Normal 

Displayed as ”AWB Completed”. 

 

 

 

 

 

 

 

 

Abnormal 

If an error message is displayed, white balance cannot be adjusted. 

Error message list  

(1) AWB LEVEL OVER 

[Condition]  AWB cannot operate normally due to excessive light intensity. 

[Response]  Adjust the amount of incident light and repeat. 

(2) AWB LEVEL UNDER 

[Condition]  AWB cannot operate normally due to insufficient light intensity. 

[Response]  Adjust the amount of incident light and repeat. 

(3) AWB NOT WHITE 

[Condition]  AWB cannot operate normally because there are not enough white areas. 

[Response]  Do not move the white photographic sample. 

(4) AWB OUT OF RANGE 

[Condition]  White cannot be taken within the adjustable range of AWB. 

[Response]  Do not move the white photographic sample. 

(5) AWB ERROR 

[Condition] AWB did not complete in time. 

[Response]  Do not move the white photographic sample. 
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4.2 Scene file 

Up to 4 scene files can be selected according to shooting conditions. 

Resetting to factory default settings is also possible. 

 

Select from TOP MENU ⇒ LOAD is selected 

  

 

 

 

 

 

 

Select [SCENE FILE] from the PICTURE screen ⇒ LOAD/SAVE/INITIALIZE is selected 

 

 

 

 

 

  

 

 

 

4.2.1 Selecting a scene file (LOAD) 

 

 

 

 

 

 

 

 

１．The button corresponding to the currently selected scene file is lit. 

２．Press the button to select a scene file. 

● The number displayed on the button is the scene file number. 

● The button corresponding to the selected scene file will be lit.  

● Settings of scene file will be immediately reflected. 
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4.2.2 Saving a scene file (SAVE) 

 

 

 

 

 

 

 

 

Adjust the desired settings in advance and save in them the scene file. 

Select [MENU]⇒[PICTURE]⇒[Scene File]⇒[Save]. 

When the scene file number for which you want to save the settings from [No.1] to [No.4] is selected, a new 

window will be displayed. 

Press the [YES] button to save the settings are saved in the selected scene file. 

 

 

4.2.3 Initializing a scene file (INITIALIZE) 

 

 

 

 

 

 

 

 

 

 Select [MENU]⇒[PICTURE]⇒[Scene File]⇒[Initialize] 

When the scene file number you want to initialize from [No.1] to [No.4] is selected, a new window will be 

displayed. 

By pressing the [YES] button, the settings of the selected scene file will be immediately set to the factory settings. 

 

 

For efficient use 

Switch scene files by assigning functions to the foot switches. 
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4.2.4 Registering a scene file 

You can change the name of the button in the file selection on the [TOP MENU] ⇒ [Scene File] screen. 

 

 

 

 

 

 

 

 

 

 

To register a file name, long press the button for about 3 seconds. 

Go to the scene file name registration screen. 

 

 

 

 

 

 

 

 

 

 

 

① Input box  

② Backspace button 

③ Character type change button 

④ Space button 

⑤ Cursor movement button 

⑦  SET (confirm) button 

 

Input characters by operating the Rotary Switch. Select a character type and press the Rotary Switch to move 

the cursor to the next character input (or use ⑤buttons). 

The maximum number of characters that can be input is 28. 

Please press the ⑥SET button when finished. 

Registration of the scene file name is complete, and the button name will be changed when returning to the 

scene file selection screen. 

 

 

 

 

 

  

① ② 

③ 

④ 

⑤ 

⑥ 
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4.3 Function key select 

Frequently used functions can be assigned to the [F1] to [F4] buttons in advance. 

 

Select from the TOP MENU ⇒ Execute assigned function 

 

 

 

 

 

 

 

 

 

 

Select [MENU] ⇒ [FUNCTION] ⇒ [FUNCTION KEY]. A function can also be assigned from the OSD menu (→

4.5.2, 5.8). 

 

 

 

4.4 Image quality adjustment (PICTURE)  

 

Select [PICTURE] from the MENU screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Go to the BRIGHTNESS setting screen. (→4.4.1) 

② Go to the CONTRAST setting screen. (→4.4.2) 

③ Go to the COLOR setting screen. (→4.4.3) 

④ Go to the SHARPNESS setting screen. (→4.4.4)  

① 

④ 

③ 

② 
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4.4.1 Brightness adjustment (BRIGHTNESS) 

 

 

 

 

 

 

 

 

 

 

 

 

① BRIGHTNESS LEVEL    ② RESPONSE   ③PEAK RATIO 

 

 

 

 

 

 

 

 

④SHUTTER CONTROL 

 

 

 

 

 

 

 

 

From the [SETTING] button go to [SHUTTER CONTROL] ⇒ [AUTO] is selected. 
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From the [SETTING] button go to [SHUTTER CONTROL] ⇒ [MANUAL] is selected. 

  

 

 

 

 

 

 

 

⑤ GAIN 

 

 

 

 

 

 

 

 

From the [SETTING] button, go to [GAIN] ⇒ [AUTO] is selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

From the [SETTING] button, go to [GAIN] ⇒ [MANUAL] is selected. 
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Item Description 

Brightness 

Level 

This item controls brightness, and can be adjusted with the touch panel or Rotary Switch 

(Linked with the OSD menu→5.1). 

Response Set the control speed when Shutter or Gain is AUTO (Linked with the OSD menu→5.1). 

Peak Ratio This item adjusts the photometric method and can be adjusted with the touch panel or 

Rotary Switch (Linked with the OSD menu→5.1). 

Shutter 

Control 

This item is for automatic adjustment of the shutter (Linked with the OSD menu→5.1). 

Gain This item determines automatic adjustment of gain. When capturing a dark sample, 

adjusting the brightness is possible. 

 (Linked with the OSD menu→5.1). 
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4.4.2 Contrast adjustment (CONTRAST) 

 

 

 

 

 

 

 

 

 

① PEDESTAL        ② FLARE 

 

 

 

 

 

 

 

 

③ GAMMA        ④KNEE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

④ HDR 
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Item Description 

PEDESTAL This adjusts the black level using the touch panel or Rotary Switch (Linked with 

the OSD menu→5.2). 

FLARE This performs flare correction using the touch panel or Rotary Switch (Linked 

with the OSD menu→5.2). 

GAMMA Gamma correction adjusts dark areas of an image so they appear brighter. 

Gamma level can be adjusted using the touch panel or rotary switch (linked to 

the OSD menu → 5.2). 

KNEE Knee correction adjusts the bright areas of the image so they are easier to see 

(Linked with the OSD menu→5.2). 

HDR HDR reduces white and black spots in the image. HDR level can be adjusted 

using the touch panel or rotary switch (linked to the OSD menu → 5.2). 
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4.4.3 Color adjustment (COLOR) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① RED LEVEL 

 

 

 

 

 

 

 

 

 

② BLUE LEVEL      ③ CHROMA LEVEL 

 

 

 

 

 

 

 

 

 

 

Item Description 

RED LEVEL This adjusts the red level using the touch panel or Rotary Switch (Linked with 

the OSD menu→5.3). 

BLUE LEVEL This adjusts the blue level using the touch panel or Rotary Switch (Linked with 

the OSD menu→5.3). 

CHROMA LEVEL This adjusts color density using the touch panel or Rotary Switch (Linked with 

the OSD menu→5.3). 
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4.4.4 Sharpness adjustment (SHARPNESS) 

 

 

 

 

 

 

 

 

 

① MODE 

 

 

 

 

 

 

 

② LEVEL       ③ BOOST FREQ. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Item Description 

MODE This changes the mode of outline emphasis.  

(Linked with the OSD menu →5.4). 

LEVEL This adjusts the level of contour emphasis using the touch panel or Rotary 

Switch. 

(Linked with the OSD menu →5.4). 

BOOST FREQ. This adjusts the level of color contour emphasis using the touch panel or Rotary 

Switch.  

(Linked with the OSD menu →5.4). 
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4.5 Function (FUNCTION)  

 

Select [PICTURE] from the MENU screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Go to the FUNCTION screen (→4.5.1) 

② Go to the FUNCTION KEY screen(→4.5.2,4.5.3) 

 

  

① ② 
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4.5.1 Scaling (MAGNIFIER)/Flip(FLIP) 

 

 

 

 

 

 

 

 

 

 

 

 

② MAGNIFIER      ③ FLIP 

 

 

 

 

 

 

 

 

 

Item Description 

MAGNIFIER This is the magnification setting of the electronic zoom and can be adjusted 

using the touch panel or Rotary Switch (Linked with the OSD menu→5.6). 

FLIP This sets the horizontal and vertical flipping of the image. (Linked with the OSD 

menu→5.6). 

 

  



42 

 

 

4.5.2 Assign a function to a function key (FUCTION KEY) 

To set an operation when the function button is pressed, go to the  

[TOP MENU] ⇒[FUNCTION KEY] screen. 

This works in conjunction with the OSD menu. 

Please refer to the menu description for the assigned function. (→5.8) 

 

 

 

 

 

 

 

 

 

 

 

4.5.3 Function assignment of the TOP MENU indicators (TOP MENU INDICATOR) 

Assign an indicator function that can be operated from TOP MENU. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

Repeat the steps for [ITEM2] and [ITEM 3]. 

To switch function, pressing the Rotary Switch in the TOP MENU. Other items can be operated from the TOP 

MENU. 

<Setting items> 

NONE (ITEM2, 3 only), BRIGHTNESS, PEAK RATIO, SHARPNESS, CHROMA, RED LEVEL, 

BLUE LEVEL 

  

PUSH 
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4.6 System settings (SYSTEM)  

 

Select [SYSTEM] from the MENU screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

① Go to the COLOR BARS screen (→4.6.1) 

② Go to the CENTER MARKER screen (→4.6.2)  

③ Go to the DATE/TIME screen (→4.6.3) 

④ Go to the OTHERS screen (→4.6.4)  

⑤ Go to the INFORMATION screen (→4.6.5) 

 

4.6.1 Color bars output (COLOR BARS) 

The camera’s built-in color bar signal is sent to the image output. 

Brightness, contrast, etc. of the color monitor can be adjusted. 

 

 

 

 

 

 

 

 

 

To display the color bar output, press [ON], to display the camera image press [OFF] 

  

① 

④ 

③ 

② 

⑤ 
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4.6.2 Center marker output (CENTER MARKER) 

Displays the center marker on the monitor. Works in conjunction with the OSD menu (→5.9). 

 

 

 

 

 

 

 

 

To display the center marker, press [ON]. To hide display of the center marker, press [OFF]. 

 

4.6.3 Date/Time setting(DATE/TIME) 

Sets the date and time. Works in conjunction with the OSD menu (→5.10). 

 

 

 

 

 

 

 

 

 

 

Set the date and time with the up and down buttons. Press the [SET] button to confirm. 

 

4.6.4 Other settings (OTHERS) 

 

 

 

 

 

 

 

 

 

 

 

① Go to the INITIALIZE screen (→4.6.4.1). 

② Go to the USB MEMORY screen (→4.6.4.2). 

③ Go to the SOUND screen (→4.6.4.3). 

④ Go to the LCD BRIGHTNESS screen (→4.6.4.4). 

⑤ Go to the LANGUAGE screen (→4.6.4.5). 

  

① 

④ 

③ 

② 

⑤ 
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4.6.4.1 Initialization (INITIALIZE) 

Setting values are returned at the default factory settings. CCU initialization can also be performed from the OSD 

menu (→5.12). 

 

 

 

 

 

 

 

 

 

 

Press the [CCU] and [FRONT] buttons to display the window. 

To initialize, press the [YES] button. 

 

4.6.4.2 USB memory (USB MEMORY) 

Setting data of CCU can be saved to and read from the USB memory. 

< USB not connected button disabled state >  

 

 

 

 

 

 

 

 

 

 

 

<USB connection Button enabled state > 

 

 

 

 

 

 

 

 

 

 

Press the [USB C CCU], [CCU⇒USB] button to display the [CCU⇒USB] window. 

Press the [YES] button to confirm. 

If the USB memory is not inserted, the button is disabled and cannot be used. 

Operation is also possible from the OSD menu, for details, refer to Save and Load Configuration Data. (→5.12) 
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4.6.4.3 Volume setting (SOUND) 

 

 

 

 

 

 

 

 

 

 

 

 

① VOLUME      ② MUTE 

 

 

 

 

 

 

 

 

 

 

Item Setting value Description 

VOLUME   Set the touch panel volume. 

 1～5 As the value increases, sound becomes louder. 

MUTE    

 ON Sound is muted. 

 OFF Sound is output according to the VOLUME setting. 
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4.6.4.4 Brightness setting (LCD BRIGHTNESS) 

 

 

 

 

 

 

 

 

 

 

 

Item Setting value Description 

LCD 

BRIGHTNESS 

  Set the brightness of touch panel. 

 1～5 As the value increases, the panel becomes brighter. 

 

 

4.6.4.5 Language setting (LANGUAGE) 

Set the display language. CCU initialization can also be performed from the OSD menu (→5.12). 
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4.6.5 Version information (INFORMATION) 

Display camera and touch panel version information. 

 
 

 

 

4.7 Initializing indicator settings  

Indicator display setting items can be returned to the default values (factory settings) after setting values have 

been changed. 

Press the function name to display the window, then press the [YES] button to return to the initial value. 
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5 OSD menu operations（Professional setting menu） 

This section describes operations of the OSD menu screen and the functions that can be set on the OSD menu 

screen. 

 
 

 Select [OSD MENU] from the MENU screen 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Press the [OSD MENU] button to display the OSD menu on the monitor. 

Select an item using ↑ / ↓.→ Press the SET button to enter the submenu screen. Change the value of each setting 

using ↑ / ↓. Return to the previous menu with ←. 

Item selection using the Rotary Switch is also possible by rotating the switch. Pressing the switch performs the 

same operation as pressing the SET button. 

※Exit the [OSD MENU] screen and hide the OSD menu to save the settings and exit. 

  

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Network 
Others 
Information 

Return to MENU 

screen and hide OSD 

menu 

Changes the setting value 

Switches item 

Sets the selected item 

Return to TOP 

MEN:@U screen and 

hide OSD menu 

Display OSD menu 
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5.1 Brightness 

Exposure time can be adjusted.

 
 

 

 

 

Item Setting value Description 

Brightness Level 

 

 This controls brightness. When Shutter or Gain is set at AUTO, brightness is 

automatically adjusted according to the level set here. 

 -128~127 If the screen is too dark, set the value higher, if it is too bright set the value 

lower. 

Response  When Shutter or Gain is set at AUTO, this controls response speed. 

 MIDDLE Adjusts at standard speed. 

 SLOW Adjusts slowly. 

 FAST Adjusts quickly. 

Photometry Measurement Area This adjusts the range of the photometry area. Shutter, Gain, etc. are 

automatically adjusted based on the image in the frame displayed on the 

screen. 

 NARROW Measurement area is approx. 40% of the screen center. 

 MIDDLE Measurement area is approx. 60% of the screen center. 

 FULL Measurement area is the entire screen. 

 CIRCLE Measurement is area is a circular area of the screen center. 

 USER Measurement is manually set. Press the SET button to go to the settings 

screen. 

 Peak Ratio This determines the photometric method. When Shutter or Gain is at AUTO, 

brightness can be changed by adjusting the metering method. If most of the 

background area is dark and the sample is bright, set it to peak photometry. If 

the difference in luminance over the entire screen is small, set it to the average 

measurement side. 

 0～63 Peak measurement is performed at 63, and average measurement is 

performed at 0. 

Brightness 
 

Quit 
Brightness Level 0 
Response  MIDDLE 
Photometry  ENTER ⇒ 

Shutter Control AUTO ⇒ 

Gain   AUTO ⇒ 
 High Sensitivity OFF 
 Line Mix  OFF 
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Shutter Control   This controls shutter operation. When shutter speed is increased, brightness 

changes according to the speed. In addition, flicker may increase under a 

fluorescent lamp and other discharge lamp lighting. 

 MANUAL Shutter speed is set according to the determined Shutter Speed value. 

 Shutter Speed Sets the shutter speed. 

 AUTO Optimal shutter speed is automatically adjusted according to the brightness of 

the image. 

 Shutter Limit Optimal shutter speed is automatically adjusted according to the brightness of 

the image. 

 Slow Shutter Enables or disables the Slow Shutter function. 

 Slow Shutter 

 Limit 

Limits the accumulated shutter speed. 

Gain   This controls the adjustment of Gain. When taking an image of a dark sample, 

brightness can be adjusted. 

 MANUAL Gain is set according to the value set in Normal Gain. 

 Normal Gain Sets the gain value. 

  AUTO Gain is automatically adjusted according to the brightness of the video input 

for a consistent output level. 

 Base Sets offset. 

 Range Sets the upper limit of gain setting when Gain is AUTO. 

High Sensitivity   This function increases sensitivity. 

 OFF Function is disabled. 

 ON Sensitivity is doubled. However, horizontal resolution is degraded. 

Line Mix   This function increases sensitivity. 

 OFF Feature is disabled. 

 ON Sensitivity is doubled. However vertical resolution is degraded. 
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5.2 Contrast 

 

Video level settings are adjusted here.

 

Item Setting value Description 

Pedestal  This determines black level. 

 -64~64 As the value increases, black becomes brighter . 

Flare  This determines flare correction. 

 0~50 As the value increases, the correction becomes stronger, and the 

image becomes tighter. 

Gamma   

 

Gamma correction lightens dark areas of the image. 

 OFF Settings are disabled. 

 ON Settings are enabled. 

 -128~127 As the value increases, the darker areas of the image become 

brighter. 

Knee   Perform knee correction to make bright areas of the image easier 

to see. 

 OFF Settings are disabled. 

 ON Settings are enabled. 

 Mode AUTO or MANUAL settings are possible. 

 Point Sets the knee point. 

 Slope Sets the knee slope. 

HDR   HDR reduces white spots and black spots in video. 

 OFF Settings are disabled. 

 ON Settings are enabled. 

 -128～127 As the value increases, the HDR function becomes stronger. 

White Shading   Adjusts white shading. 

 OFF Correction is disabled 

 ON Settings are enabled. 

Black Stretch   Adjusts the black stretch. 

 OFF Correction is disabled. 

 ON Correction is enabled 

Contrast 
 

Quit 
Pedestal  0 
Flare   7 
Gamma   ON ⇒ 

Knee   ON ⇒ 
HDR   OFF 
White Shading  OFF 

 Black Stretch  OFF 
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   0～63 As the value increases, the Black Stretch function becomes stronger. 



54 

 

5.3 Color 

Settings related to image color are made here.

 
 

Item Setting value Description 

Red Level  This adjusts the red level. 

 -128~127 As the value increases, red becomes darker. 

Blue Level  This adjusts the blue level. 

 -128~127 As the value increases, blue becomes darker. 

White Balance   White balance operations are set here. 

AWB White balance is automatically adjusted. 

ATW White balance automatically adjusted according to the 

sample to be imaged. 

MANUAL White balance can be manually adjusted. 

Red Level Adjusts the red gain. 

Blue Level Adjusts the blue gain. 

Chroma Level   This adjusts color saturation. 

-128～127 As the value increases, the color becomes darker. As the 

value decreases, the color becomes lighter. 

Matrix   The color matrix is adjusted here. 

Normally, set it to OFF. 

  OFF Adjustment is disabled. 

  ON Adjustment is enabled. 

Color Correct   Color collection is adjusted here. 

Normally, set it to OFF. 

 OFF Adjustment is disabled. 

 ON Adjustment is enabled. 

  

Color 
 

Quit 
Red Level  0 
Blue Level  0 
White Balance  AWB ⇒ 
Chrome Level  0 
Matrix   OFF 

 Color Correct  OFF 
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5.4 Sharpness 

Outline emphasis can be adjusted here. 

 
Item Setting value Description 

Level  The level of outline emphasis can be adjusted. 

 0~31 As the value increases, the image becomes sharper. 

Boost Freq.  Boost frequency can be adjusted to emphasize the 

contour. 

 2MHz~16MHz As the value decreases, the outline can be applied to 

the whole screen more easily. 

Mode  Outline emphasis mode can be switched 

 SOFT Standard outline emphasis setting. 

HARD Outline emphasis becomes stronger. 

 

  

Sharpness 
 

Quit 
Level   16 
Boost Freq.  2MHz 
Mode   SOFT 
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5.4 Scene File 

 

Setting value information can be saved and read as a scene file. 

Up to 4 scene files can be created. 

 
 

Item Description 

Load Selects and reads the set scene file. 

Save Saves the set conditions in the scene file. Select the scene file to be 

saved, and press the OK button. 

Initialize Initializes the scene file settings at factory default settings. Select the 

scene file to initialize and press the ENTER button. 

 

  

Scene File 
 

Quit 
Load   No.1 
Save   READY 
Initialize  READY 
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5.6 Function 

Various functions can be set here. 

 

 
Item Setting value Description 

Magnifier  The magnification setting of the electronic zoom can 

be set here. 

 x1.0~x4.0 The center of the screen can be zoomed in at 0.1x 

increments. 

Flip  Horizontal and vertical aspects of the image can be 

flipped. 

 OFF Both horizontal and vertical aspects are output as is. 

H FLIP A horizontally inverted image is output. 

V FLIP A vertically inverted image is output. 

ROTATE A both horizontally and vertically inverted image is 

output. 

DNR Level   Adjusts the level of noise reduction. 

0～31 As the value increases, noise will decrease, but 

resolution degrades. 

 

  

Function 
 

Quit 
Magnifier  x 1.0 
Flip   OFF 
DNR Level  7 
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5.7 Foot Switch 

The function assigned to the foot switch can be set here. Up to 4 footswitch functions can be individually set. 

Item Setting value Description 

Switch1~4  Which function will occur when the foot switch is 

operated can be set here. The foot switch function 

supports up to 4 operations, and each can be individually 

set. 

 NONE No function is set. 

FREEZE Outputs a still image. Operate the foot switch again to 

return to the video. 

SCENE F(ROT) Switches the selected scene file. 

H FLIP A horizontally inverted video is output. 

V FLIP A vertically inverted video is output. 

ROTATE The image is rotated 180 degrees and output. 

ZOOM IN Performs electronic zoom in. 

ZOOM OUT Performs electronic zoom out. 

AWB Adjusts the white balance. 

SCENE1 Displays scene file1. 

SCENE2 Displays scene file2. 

SCENE3 Displays scene file3. 

SCENE4 Displays scene file4. 

SCENE1<->2 Switches between scene file 1 and 2. 

SCENE1<->3 Switches between scene file1 and 3.   

SCENE1<->4 Switches between scene file1 and 4. 

SCENE2<->3 Switches between scene file2 and 3. 

SCENE2<->4 Switches between scene file2 and 4. 

SCENE3<->4 Switches between scene file3 and 4. 

 

  

Foot Switch 
 

Quit 
Switch1  NONE 
Switch2  NONE 
Switch3  NONE 
Switch4  NONE 
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5.8 Function Key 

A function can be assigned to a function button here.

 
Item Setting value Description 

Key1~4   Which function will occur when the function key is 

pressed can be set here. 

 NONE No function is set. 

H FLIP A horizontally inverted image is output. 

V FLIP A vertically inverted video is output. 

ROTATE The image is rotated 180 degrees and output. 

ZOOM IN Performs electronic zoom in. 

ZOOM OUT Performs electronic zoom out. 

FREEZE Outputs a still image. Operate the function button 

again to return to the video. 

 

  

Function Key 
 

Quit 
Key1   NONE 
Key2   NONE 
Key3   NONE 
Key4   NONE 
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5.9 Video Format 

Video signal related aspects can be set here. 

 

 
 

 

 

Item Setting value Description 

Frame Rate   Selects the frequency of the video output signal. 

 59.94Hz Output at 59.94 Hz. 

 50Hz Output at 50 Hz. 

4K SDI Output   Selects the frequency of the video output signal. 

 2SI Outputs in 2 Sample Interleave format. 

 12G Outputs in 12G-SDI format. 

2K SDI Output   Selects the output signal of 2K SDI. 

 1080p Outputs a progressive signal. 

 1080i Outputs an interlace signal. 

DVI Output   Selects the output signal of DVI. 

 1080p Outputs a progressive signal. 

 1080i Outputs an interlace signal. 

HDMI Output    

 AUTO This setting is normally used. 

 4K  

  4:2:2 10bit Outputs YCbCr and a 10-bit signal at a ratio 

of 4: 2: 2. 

  4:4:4 8bit Outputs RGB as 8-bit signal. 

 2K  

  1080p 4:2:2 10bit Outputs YCbCr and a 10-bit progressive 

signal at a ratio of 4: 2: 2. 

  1080p 4:4:4 8bit Outputs RGB as an 8-bit progressive signal. 

  1080i 4:2:2 10bit Outputs YCbCr and a 10: 2 interlaced signal 

at a ratio of 4: 2: 2. 

  1080i 4:4:4 8bit Outputs RGB as an 8-bit interlaced signal. 

  

Video Format 
 

Quit 
Frame Rate  59.94Hz 
4K SDI Output  2SI 
2K SDI Output  1080i 
DVI Output  1080p 
HDMI output  AUTO 
Color Gamut  BT.709 
H Position  0 
V Position  0 
Genlock  OFF 
Center Marker   OFF 
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Color Gamut   Selects the color gamut for 4K output. 

 BT.709 Sets the color gamut for 4K output at BT.709. 

 BT.2020 Sets the color gamut for 4K output at BT.2020. 

H Position  -32~32 The horizontal display of the screen can be adjusted in 1-pixel units. 

V Position  -8~8 The vertical display of the screen can be adjusted in single line units. 

 

Genlock   Genlock can be set here. 

 OFF The genlock feature is disabled. 

 AUTO When a SYNC signal is input to the genlock terminal, it automatically 

switches to external synchronization. 

 H Phase Adjusts the horizontal phase of genlock input. 

 V Phase Adjusts the vertical phase of genlock input. 

 3D Support Sets whether to operate as master or slave at 3D configuration. 

Center Maker   Displays the center marker. 
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5.10 Date/Time 

To set the time of the clock function installed in this unit. 

The update date and time of the setting data must be matched.

 
Item Description 

Year  

 

Each aspect to set the time. 

Month 

Day 

Hours 

Minutes 

 

  

Date/Time 
 

Quit 
Year   2019 
Month   3 
Day   2 
Hours   11 
Minutes  34 
Seconds  20 
Setting  READY 
 
  2019-03-02 
    11:34:20 
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5.11 Network 

This unit can be externally controlled by a LAN connection. The network can be set up here.  

 
 

Item Description 

IP Address1~4 Sets the IP Address. 

Subnet Mask1~4 Sets the subnet mask. 

Setting To change settings, switch from [READY] to [START] and press the 

ENTER button. 

 

Current settings are displayed in the lower part of the screen. 

※After changing the settings, restart the camera. 

If "Please Restart Camera" is displayed at the bottom of the screen, please restart. 

Changes to the network configuration are complete. 

 

  

Network 
 

Quit 
IP Address1  192 
IP Address2  168 
IP Address3  2 
IP Address4  100 
 
Subnet Mask1  192 
Subnet Mask2  168 
Subnet Mask3  2 
Subnet Mask4  1 
Setting           READY 
 
  IP Address 
  192.168.2.100 
  Subnet Mask 
  192.168.2.1 
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5.13 Information 

Software version information is displayed here. 

 

 
 

  

Information 
 

CCU Firmware  V1.00-6368 
CCU FPGA1  V1.00-6305 
CCU FPGA2  V1.00-6306 
CCU FPGA3  V1.00-6255 
Head FPGA  V1.00-6209 
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6 Advance Use 

External Synchronization 

To use this machine in external synchronization mode, connect the SYNC terminal to the GENLOCK terminal on 

the CCU back. When SYNC terminal is connected to the GENLOCK terminal, the camera will automatically switch 

from internal synchronization mode to external synchronization mode. 

SYNC input conditions: Tri-level SYNC: 0.6 Vp-p / 75 Ω 

 

 Wiring Example 

Prepare two sets comprised of a CCU and a MKC-X800 camera. Use a coaxial cable to connect the SYNC 

connector on the CCU (master) and the GENLOCK connector on the CCU (slave). 

 

 

 

 

 

 
 

 

 

 
 

 

 

 

  

CCU (master) 

 

SYNC connector 

 

CCU (slave) 

 

GENLOCK connector 

 

Camera (master) 
 

Camera (slave) 
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 Settings 

Check the SYNC output waveforms of the master CCU and the slave CCU, and adjust PHASE so that both H/V 

phases are the same. The slave (unit with the GENLOCK connector connected) should be targeted for adjustment. 

The master unit does not need the phase adjustments. 

 
 

3D support function 

This device has a 3D support function. The settings of various camera functions of the left and right units can 

be synchronized and easily adjusted when the 3D system is constructed. 

 

 Connections and settings 

The 3D system for this equipment is comprised of one master machine, one slave machine and a 3D-compatible 

monitor. Connect each device as shown in the figure below. 

 

■Connection Example 

 

 

 

 

位相を合わせる 

CCU (Master) 

 
CCU (Slave) 

 Coaxial cable 

 

RS-232C cross cable 

ル 

Video output cable 
HD-SDI or DVI 
 

3D-compatible monitor 

 

Video output cable 
HD-SDI or DVI 

Master SYNC 

Slave SYNC 

Make phases consistent 
with each other 
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■Setting the master and the slave 

１． Use a coaxial cable to connect the SYNC connector of the master CCU and the GENLOCK connector of the 

slave CCU. Next, connect RS-232C connector comrade using a RS-232Ccross cable (D-Sub 9-pin Female). 

 

２． Connect the two CCUs and the monitor. 

※Connect both CCU output signals to the 3D-compatible monitor 

※Either camera can be set as the master. 

※Check the specifications of the monitor regarding output connection of the left or right camera. 

 

３． Turn ON the main power switch.（possible from either CCU.） 

 

４． From the MENU, go to [Video Format]→[Genlock]→[3D Support]. Next, change camera settings in ’Master’ 

for the Master CCU, and in ’Slave’ for the Slave CCU. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Caution During Connection 

・ Before connecting, be sure the power to the camera is OFF. 

 

  

Video Format 
 

Frame Rate  59.94Hz 
4K SDI Output  2SI 
2K SDI Output  1080p 
DVI Output  1080p 
HDMI Output  4K➩ 
H Position  0 
V Position  0 
Genlock  OFF 
Center Marker  OFF 

 

Video Format→Genlock 
 

H Phase 0 
V Phase 0 
3D Support SLAVE 
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 Linking the operation panel and menu 

When settings are complete, [White balance], [Auto shutter], [Auto sensitivity], [Auto Iris] and [Set value of 

each volume] etc. are interlocked between the master and the slave, and settings of the master CCU are 

automatically reflected in the slave CCU. 

 

 

Manually Setting a Measuring Frame 

The range of a measuring frame can be adjusted. When the measuring frame is adjusted, the video will 

automatically be adjusted according to the use environment. 

  

 Settings 

Select [Exposure]→[Measurement Area]→[USER] from the menu, and press the set button. The manual setting 

screen for the measuring frame will be displayed.  

Pressing the SET button will change in order of [Quit]→[Position]→[Top&Left]→[Bottom&Right]→[Quit]. 

 
Position and size of a measuring frame can be adjusted. When settings are complete, select QUIT and press the 

SET button. 

 

 

Setting the Position 

To adjust the position of a metering frame, select [Position] and press the SET button. Frame size will not 

changed. 

 
Use the ⇧/⇨/⇩/⇦keys to adjust the position. 

  

 
 

 
 

Position 
 

 

 
 

 
 

Position 
 

 

Move a frame. 
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Setting the Size 

Select [Top&Left] or [Bottom&Right] to adjust the size of a measuring frame. 

 
Use the ⇧/⇨/⇩/⇦ keys to adjust the position. 

[Top&Left] ：Adjusts the size of left and upper sides of a metering frame. 

Enlarges with “↑”/“←”key. Reduces with  “↓”/“→”key. 

[Bottom&Right] ：Adjusts the size of lower and right sides of a metering frame. 

Enlarges with “↓”/“→”key. Reduces with  “↑”/“←”key. 

 

 

5.12 Others 

Settings can be set to factory default settings. 

Save or overwrite the setup data in the USB memory. 

 

 
Item Setting value Description 

Initialize   Initialize all settings except the scene file to factory default 

settings. 

Switch from [READY] to [START] and press the ENTER button. 

USB Memory 

 

  Data can be read and saved on USB memory 

 NO MEDIA USB memory is not inserted. 

 READY USB memory is inserted and data can be read and saved. 

 CCU→USB Saves CCU data on USB memory. 

 USB→CCU Loads data from USB memory into CCU. 

Language   Various languages can be displayed 

 

 
 

 
 

[Bottom&Right] 
 

 

Changing the frame 
size 

 

Others 
 

Initialize  READY 
USB Memory  NO MEDIA 
Language  ENGLISH 
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Scene File 

Up to four scene files can be set according to photographic conditions. Resetting to factory default settings is 

also possible. 

 

 Saving a Scene File 

A scene file can be created from the menu. Since the present settings are saved in the scene file, set the 

desired settings first. 

From [Scene File] on the menu, select one of the alternatives: [Save Scene 1] to [Save Scene 4], and press 

the SET button. The new settings will be saved immediately to the scene file. (refer to 4.2 Scene File.) 

 

 Initializing a Scene File 

From [Scene File] on the menu, select a file to initialize from the alternatives: [Initialize Scene 1] to [Initialize 

Scene 4], and press the SET button. The selected scene file will immediately be initialized.  

 

 Setting a Scene File 

To use a saved scene, use the front panel (Please see 4.2.1).  
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USB 

Settings data can be saved in a USB memory. Also, settings data saved in the USB memory can be loaded. 

 

■Connection port 

 

 
 

 

■Before using 

 

 

 

 

 

 

 

 

 

  

Compatible USB Memory 

・USB memory protected by a password is not supported. 

・FAT32 and FAT16 for the file system of USB memory are supported. USB memory formatted 

with another file system is not supported. 

・Use a USB memory with 1MB or more of free space. 
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 Saving a set data 

 

When a USB memory is inserted, [USB Memory] status of [Others] changes from [NO MEDIA] to [READY]. 

 

 
Move the cursor to [USB Memory] [READY], selects [CCU⇒USB] using the [↑] [↓] buttons, press [SET]. The set 

data is saved to the USB memory. 

When data is being saved to the USB memory, ”USB Memory Busy” will be displayed on the bottom of the 

screen. 

When the data has been saved, ”USB Memory Completed” will be displayed and the [USB Memory] returns to 

[READY]. Saving takes about 15-60 sec. 

 

 
Cautions regarding USB memory access. 

Do not remove the USB memory or turn off the power, while "USB Memory Busy" 

is displayed. 

If the USB memory is removed while being accessed, or the equipment is turned 

off, data in the USB memory may become corrupt. 

Use a USB memory that has more than 1MB of a free space when saving a set data. A set data is saved with the 

file name extension "msf" in the root directory of the USB memory. The file name to be saved cannot be changed. 

 

Cautions when saving a set data. 

Others 
  

Initialize  READY 
USB Memory  READY 
Language  ENGLISH 
  
  

Others 
 

Initialize READY 
USB Memory CCU⇒USB 
Language  ENGLISH 
 

 
 
 

USB Memory Busy 

Others 
 

Initialize READY 
USB Memory READY 
Language  ENGLISH 
 

 
 
 
USB Memory Completed 

If 'NO MEDIA’ is displayed, 

the USB memory is not recognized. Check the following. 

・Be sure the USB memory is inserted all the way. 

・Remove the USB memory, and the re-insert it. 

・Increase the amount of free space on the USB memory (recommended: 1MB or 

more), and try again. 

If it is not improved, consult with sales representatives or use the equivalent product. 

CAUTION: 
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When a setting data is saved on a USB memory, any past set data will be overwritten and lost. 



74 

 

When saving of the set data is unsuccessful, ”USB Memory Error” will appear. 

 
 

Cautions when saving is unsuccessful. 

 

 

 

 Loading a set data 

Move the cursor to [USB Memory] [READY], select [USB⇒CCU] using the [↑] [↓] buttons, press [SET]. The 

set data is read from the USB memory. 

When data is being read from the USB memory, ”USB Memory Busy” will be displayed on the bottom of the 

screen. 

When the data has been read, ”USB Memory Completed” will be displayed and the [USB Memory] returns to 

[READY]. Reading takes about 30 sec. 

 

 
 

Cautions regarding USB memory access. 

Do not remove the USB memory or turn off the power, while "USB Memory Busy" 

is displayed. 

If the USB memory is removed while being accessed, or the equipment is turned 

off, data in the USB memory may become corrupt. 

 

Cautions when loading a set data. 

 

 

  

When saving a set data is unsuccessful, delete the data in the USB memory and increase the 

free space or use another USB memory. 

A set data saved in another IKEGAMI model cannot be read in MKC-X800. 

Others 
 

Initialize READY 
USB Memory READY 
Language  ENGLISH 
 
 
 
 
 
 
 

USB Memory Error 

Others 
 

Initialize READY 
USB Memory USB⇒CCU 
Language  ENGLISH 
 

 
 
 

USB Memory Busy 

Others 
 

Initialize READY 
USB Memory READY 
Language  ENGLISH 
  

 
 
 
USB Memory Completed 

CAUTION: 
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 Notes on USB Memory Access 

Do not remove the USB memory or turn off the power while “USB Memory Busy” is displayed. Removing the 

USB memory or turning off the power while accessing may damage the data in the USB memory. 

Notes on Saving Setting Data  

When a setting data is saved on a USB memory, any past set data will be overwritten and lost. 

Notes on the Setting Data 

・Setting data saved on other IKEGAMI devices cannot be loaded to MKD-800IR. This may also result in a 

malfunction. Do not change the data. 

・Do not change the file name of the setting data. If the file name is changed, MKD-800IR cannot recognize the 

data. It may also result in malfunction. Do not change the data. 
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7 Default Settings 

 

Brightness 

Item Initial Value Setting Range 

Brightness Level 0 -128～127 

Response MIDDLE FAST, MIDDLE, SLOW 

Photometry ENTER→ ENTER→ 

Photometry->Measurement 

Area 

MIDDLE NARROW, MIDDLE, FULL, USER 

CIRCLE 

Photometry->Peak Ratio 12 0～63 

Shutter Control AUTO MANUAL, AUTO 

Shutter->Shutter Limit 

(Shutter = AUTO) 

1/4000 1/100, 1/125, 1/250, 1/500, 1/1000, 

1/2000, 1/4000, 1/5000, 1/6400, 

1/8000, 1/10000 

Shutter->Slow Shutter 

(Shutter = AUTO) 

DISABLE ENABLE, DISABLE 

Shutter->Slow Shutter Limit 

(Shutter = AUTO) 

50Hz       : 1/12 

59.94Hz  : 1/15 

50Hz       : 1/3, 1/6, 1/12, 1/25 

59.94Hz  : 1/4, 1/8, 1/15, 1/30 

Shutter->Shutter Speed 

(Shutter = MANUAL) 
OFF 

50Hz       : 1/3, 1/6, 1/12, 1/25, 

59.94Hz  : 1/4, 1/8, 1/15, 1/30, 

OFF, 1/100, 1/125, 1/250, 1/500, 

1/1000, 1/2000, 1/4000, 1/10000 

Gain AUTO MANUAL, AUTO 

Gain->Base 

(Gain = AUTO) 
3dB 

0dB 3dB, 6dB, 9dB, 12dB, 15dB 

Gain->Limit 

(Gain = AUTO) 
9dB 

3dB, 6dB, 9dB, 12dB, 15dB, 18dB 

Gain->Normal Gain 

(Gain = MANUAL) 
3dB 

0dB 3dB, 6dB, 9dB, 12dB, 15dB, 

18dB, 21dB, 24dB, 27dB, 30dB, 33dB 

High Sensitivity OFF OFF, ON 

Line Mix OFF OFF, ON 
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Contrast 

Item Initial Value Setting Range 

Pedestal 0 -64～64 

Flare 7 0～50 

Gamma ON OFF, ON 

Gamma->Level 

(Gamma= ON) 

0 -128～127 

Knee ON OFF, ON 

Knee->Mode 

(Knee = ON) 

AUTO AUTO, MANUAL 

Knee->Point 

(Knee = ON, Mode = AUTO) 

-56 -128～127 

Knee->Slope 

(Knee = ON, Mode = AUTO) 

50 -128～127 

Knee->Point 

(Knee = ON, Mode = MANUAL) 

-56 -128～127 

Knee->Slope 

(Knee = ON, Mode = MANUAL) 

50 -128～127 

HDR OFF OFF, ON 

HDR->ON 0 -128～127 

White Shading OFF OFF, ON 

White Shading->AUTO 

(White Shading = ON) 

READY READY,START 

White Shading->Initialize 

(White Shading = ON) 

READY READY,START 

Black Stretch OFF OFF, ON 

Black Stretch->Slope 

(Black Stretch = ON) 

0 0～63 
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Color 

Item Initial Value Setting Range 

Red Level 0 -128～127 

Blue Level 0 -128～127 

White Balance AWB ATW, AWB, MANUAL 

White Balance->AUTO 

(White Shading = AWB) 
READY READY,START 

White Balance->Red Level 

(White Balance = MANUAL) 
0 -128～127 

White Balance->Blue Level 

(White Balance = MANUAL) 
0 -128～127 

Chroma Level+C59:C100 0 -128～127 

Matrix OFF OFF, ON 

R-G 0 -170～342 

R-B 0 -170～342 

G-R 0 -170～342 

G-B 0 -170～342 

B-R 0 -170～342 

B-G 0 -170～342 

Color Correct OFF OFF, ON 

Page 1/2 1/2, 2/2 

Mg1 Gain 0 -64～63 

Mg1 Phase 0 -32～31 

Mg2 Gain 0 -64～63 

Mg2 Phase 0 -32～31 

Mg3 Gain 0 -64～63 

Mg3 Phase 0 -32～31 

R1 Gain 0 -64～63 

R1 Phase 0 -32～31 

R2 Gain 0 -64～63 

R2 Phase 0 -32～31 

R3 Gain 0 -64～63 

R3 Phase 0 -32～31 

Ye1 Gain 0 -64～63 

Ye1 Phase 0 -32～31 

Ye2 Gain 0 -64～63 

Ye2 Phase 0 -32～31 

G1 Gain 0 -64～63 

G1 Phase 0 -32～31 

G2 Gain 0 -64～63 
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G2 Phase 0 -32～31 

G3 Gain 0 -64～63 

G3 Phase 0 -32～31 

Cy1 Gain 0 -64～63 

Cy1 Phase 0 -32～31 

Cy2 Gain 0 -64～63 

Cy2 Phase 0 -32～31 

Cy3 Gain 0 -64～63 

Cy3 Phase 0 -32～31 

B1 Gain 0 -64～63 

B1 Phase 0 -32～31 

B2 Gain 0 -64～63 

B2 Phase 0 -32～31 

 

 

 

Scene File 

Item Initial Value Setting Range 

Load No.1 READY, No.1～No.4 

Save READY READY, No.1～No.4 

Initialize READY READY, No.1～No.4 

 

Function 

Item Initial Value Setting Range 

Magnifier x1.0 x1.0～x4.0（x0.1 intervals） 

Flip OFF OFF, H Flip, V Flip, Rotate 

DNR Level 7 0～31 
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Foot Switch 

Item Initial Value Setting Range 

Switch 1～4 NONE 

NONE, FREEZE, SCENE F(ROT), 

H FLIP, V FLIP, ROTATE,  

ZOOM IN, ZOOM OUT, SHUT CONT, 

GAIN CONT, IRIS CONT, AWB,  

SCENE 1<->2, SCENE 1<->3,  

SCENE 1<->4, SCENE 2<->3,  

SCENE 2<->4, SCENE 3<->4, 

 

Function Key 

Item Initial Value Setting Range 

Key 1～4 NONE 

NONE, FREEZE, H FLIP, V FLIP, 

ROTATE,  

ZOOM IN, ZOOM OUT, 

 

Video Format 

Item Initial Value Setting Range 

Frame Rate 59.94Hz 59.94Hz, 50Hz 

4K SDI Output 2SI 2SI,12G 

2K SDI Output 1080i 1080p,1080i 

DVI Output 1080p 1080p,1080i 

HDMI Output AUTO AUTO, 4K, 2K 

HDMI Output->Format 

(HDMI Output = 4K) 
4:4:4 8bit 4:4:4 8bit, 4:2:2 10bit 

HDMI Output->Format 

(HDMI Output = 2K) 
1080p 4:4:4 8bit 

1080p 4:4:4 8bit, 1080p 4:2:2 10bit, 

1080i 4:4:4 8bit, 1080i 4:4:4 10bit 

Color Gamut BT.709 BT.709, BT.2020 

H Position 0 -32～32 

V Position 0 -32～32 

Genlock Mode OFF AUTO, OFF 

Genlock->H Phase 

(Genlock Mode = AUTO) 
0 -128～127 

Genlock->V Phase 

(Genlock Mode = AUTO) 
0 -128～127 

3D Support 

(Genlock Mode = AUTO) 
SLAVE SLAVE, MASTER 

Center Marker OFF OFF, ON 
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Date/Time 

Item Initial Value Setting Range 

Year 2000～2099  

Month 1～12  

Day 1～31  

Hours 0～23  

Minutes 0～59  

Seconds 0～59  

Setting READY, SET READY 

 

Network 

Item Initial Value Setting Range 

IP Address1 192 0～255 

IP Address2 168 0～255 

IP Address3 2 0～255 

IP Address4 100 0～255 

Subnet Mask1 192 0～255 

Subnet Mask2 168 0～255 

Subnet Mask3 2 0～255 

Subnet Mask4 1 0～255 

Setting READY READY, SET 

 

Others 

Item Initial Value Setting Range 

Initialize READY READY, START 

USB Memory READY CCU→USB, USB→CCU 

Language ENGLISH 
ENGLISH, DEUTSCH, 

FRANÇAIS,ESPAÑOL 

 

  



82 

 

8 Specifications 

Rating 

(1) Lens mount C-mount 

(2) Image pickup device 1/2.52-inch CMOS sensor 

(3) Output (pixels) 4K output 3840×2160 pixels 

(4) Scan mode Progressive scan 

(5) External synchronization input Tri-level SYNC: 0.6 Vp-p / 75 Ω 

(6) Video output signal 

4K output 3840×2160P 59.94/50Hz 

  3G/HD-SDI (4 lines) 

  12G-SDI 

  HDMI2.0 

2K output  1920×1080P 59.94/50Hz 

   1920×1080I 59.94/50Hz 

 DVI (1 line) 

 HDMI2.0 

(7) Input Control Signal RS-232C (1 line), 9-pin D-Sub, male 

 FOOT SWITCH (1 line), 9-pin D-Sub, female 

(8) Power supply AC 100-230V ±10% (50/60Hz) 

 DC +12V 

(9) Power consumption Camera head:2.7W or less/CCU:30W or less 

(10) Operating Temperature 0℃ to +40℃ 

(11) Storage Temperature -20℃ to +60℃ (No moisture condensation, with humidity less than 90%) 

(12) Relative Humidity 0% to 90% (No moisture condensation) 

(13) Atmospheric pressure 700hPa to 1060hPa 

(14) Outline dimensions/weight Camera head:W27.5×H28×D50mm/80g or less 

 CCU: W210×H88×D274mm/3kg or less 

(15) Camera cable 5+10m cable (Microscope application)/5m (Rigid scope application) 

(standard option) 

(16) Accessories Operation Manual, Camera cable, AC adapter, AC cable 

 

Performance 

(1) Resolution（center） 

 1800TV lines 

(2) S/N ratio 58 dB targeted  

(3) Sensitivity Standard：F5,6 (2000lux/3200k) (visible light) 
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Function 

No Item Details 

1 Manual gain setting 0db to +33db 

2 
Auto gain setting 

Base : 0db to +15db 

3 Range : +3db to +18db 

4 Sensitivity up Horizontal addition, vertical addition, horizontal vertical addition 

5 Shutter setting OFF to 1/10000 sec 

6 
Slow shutter setting 

59.94Hz : 1/30 to 1/4 sec 

7 50Hz : 1/25 to 1/3 sec 

8 Auto shutter setting 1/100 to 1/10000 sec 

9 

Auto control 

Auto white balance 

10 Auto gain 

11 Auto shutter 

12 Auto KNEE 

13 AE area Narrow / Middle / Full / Circle / User 

14 AE level adjustment  

15 AE speed adjustment Slow / Middle / Fast 

16 Peak ratio adjustment  

17 Pedestal adjustment  

18 Flare correction  

19 Shading correction  

20 Paint R, Bch ± 3dB 

21 GAMMA correction  

22 KNEE correction  

23 Contrast enhancement  

24 DTL  

25 NR  

26 16-axis color matrix  

27 Freeze  

28 Video reversal Left and right/ Up and down/ Up down left right 

29 Digital zoom Up to 4 times 

30 Center marker indication  

31 Color bar internal organs  

32 Picture shift V：±8 line / H：±32 pixel 

33 Scene file SAVE / LOAD 

34 3D support MASTER / SLAVE 

35 Firmware update Update data from USB (CCU board only) 

36 HD cut out  

37 OSD menu Multilingual support (English / French / German / Spanish) 
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9 Appearance 

Camera Head 
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CCU 
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10 Troubleshooting 

Some problems may not be due to malfunction of the device. Please check the following before requesting 

repair. 
 

Common problems and solutions 

Start-up 

 

Symptom Cause Solution 

The device does not 

start when the power 

switch is turned on. 

The blue indicator is not lit. 

The device is not connected to 

an AC power supply. 

Turn off the power switch, and check the 

connection of the power cable. 

After confirming the connection, turn on the 

power switch and check it again. 

If the problem is not solved, repair may be 

needed. Please contact to the sales 

representatives. 

 

Shooting 
 

Symptom Cause Solution 

Only a black screen is 

displayed. 

The CCU and monitor is not 

properly connected. 

Check the connection to the monitor. 

The shutter is completely closed. Change the AE setting. 
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Symptom Cause Solution 

The screen shows color 

bars when the color bar 

button is not pressed. 

This device automatically shows 

the color bars when the camera 

head and CCU cannot 

communicate normally. 

This is not malfunction. 

Turn off the power switch, and check the 

following.  

1. Check the camera cable connection. 

Be sure the camera cable of the camera 

head side is firmly inserted, then turn and 

tighten the connector. 

If the problem is not solved, go to 

Step 2                

2. Replace the camera cable, and check 

it again. 

If a new camera cable is needed, 

contact the sales representative. 

If the problem is not solved, go to Step 3. 

3. Further professional examination is needed, 

contact the sales representative and return 

the device. 

. 

The screen suddenly 

turns black. 
・The output cable has been 

removed or broken 

・Forced stop due to a thermal 

runaway 

1. Check the output cable 

connection. If the problem is 

not solved, go to Step 2. 

2. Replace the output cable and check 

it again. If the problem is not 

solved, go to Step 3. 

3. Check if the lights of the front panel switch 

are on. If all lights are off, thermal runaway 

may have been occurred. The device may 

have experienced a forced stop because it was 

operated for a prolonged period under 

conditions which exceeded recommended 

operating temperature and humidity (Refer to 

P7.1 Rating). 

・Continued use of the device may 

result in unexpected accidents. 

Immediately turn off the power. 

Confirm that operating conditions are 

appropriate, and check if the device 

starts up normally. 

・ If the lights are on, professional 

examination is needed. Contact to a 

sales representative and return the 

device. 
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Symptom Cause Solution 

The device is making a 

strange noise or the 

image is distorted. 

・ The camera head and 

camera cable are not 

firmly connected. 

・Camera cable failure 

・Others 

1. Check the camera cable 

connection. Be sure the camera 

cable of the camera head side is 

firmly inserted, then turn and 

tighten the connector. 

If the problem is not solved, go to 

Step 2                

2. Replace the camera cable, and 

check it again. 

. If a new camera cable is needed, 

contact the sales representative. 

If the problem is not solved, go to 

Step 3                

3. Further professional examination 

is needed, contact the sales 

representative and return the device. 
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Error Message 

 

An error message regarding camera head connection monitoring 

Message Menu 

Head communication interrupted An error occurred in communication with the camera head. 

Head response failed An error occurred in the camera head. 

Check the head connection An error occurred in the video signal. 

 

 

 

 

 

 

 

 

 

 

 

 

The error message regarding Auto White Shade 

Message Menu 

ERROR The difference in brightness level of the sample is too large. 

 

 

The error message regarding USB memory function  

Message Menu 

USB Function Aborted The USB function has been interrupted. 

USB File Error The file is invalid. 

USB Memory Error An error occurred in communication with the USB board. 

 

 

 

  

The error message  regarding  Auto White Balance 

Message Menu 

AWB LEVEL OVER The sample is too bright. 

AWB LEVEL UNDER The sample is too dark. 

AWB NOT WHITE A white area cannot be detected on the sample. 

AWB OUT OF RANGE The control range of R gain or B gain has been exceeded. 

AWB ERROR 
The AWB pull-in operation could not be completed within the 

specified time (20 seconds). 
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MKC-X800 

Operation Manual 
 

1st Edition: July 2019 
Published in Utsunomiya Factory of 

Ikegami Tsushinki Co., Ltd. 
 

Ikegami Tsushinki Co., Ltd. 
 

◼ All rights reserved. Reproduction or duplication of the text or pictorial content, whole or 

in part and in any manner, without permission by Ikegami Tsushinki Co., Ltd., is strictly 

prohibited. 

◼ Specifications and design are subject to change without prior notice. 
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